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• If an error or improper operation occurs in our product, or customer-made programs should be found

defective, protection and safety circuits, etc should be provided for safety of the system to be used. In
addition, safety measures should be taken against personal injury or fatal accident to the system. 

• A part or all of the information contained herein is prohibited from duplication without SHINKO
TECHNOS 's written consent. 

• This manual is subject to change without previous notice. 

• Although we always keep track of the information contained herein to assure accuracy, SHINKO
TECHNOS will not be responsible for any damage to the system due to mistakes, skip or misuse in
writing  

• Be sure to read the Readme.text file included in CD-ROM. 

• Depending on the environment to be used and the usage, it may not operate normally. 

• Please note that operation except the Personal Computer which made by maker, such as self-assembled
PC and so on, cannot be guaranteed. 

WARNING 

(Note) Windows 2000/XP/Me/98/95/NT are registered trademarks of Microsoft Corporation. 

 

 

• It is prohibited to transfer part or all of this manual without SHINKO TECHNOS's permission in 
written format.  

• Description in this manual will be changed without prior notice for further improvement. 

Request 
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1. OUTLINE

1.1 Foreword 
This instruction manual describes installation and operation for the parameter loader of the paperless 
recorder. Read it carefully before use. 

 

1.2 Parameter loader for paperless recorder 
Connect the parameter loader (hereafter referred to as loader) to the paperless recorder using 
commercially available USB cable or LAN cable, and referencing (uploading), editing, and setting 
(downloading) of each parameter of the paperless recorder can be made. Connect USB miniB type 
male connector to the paperless recorder. 
Note: Optionally available dedicated cable is required to use the loader for program versions V01A to 

V22A of the paperless recorder GR200 main unit. 

 

1.3 Contents of package 
The following items are packaged with the product. 

• CD-ROM for installation: 1 
• Instruction manual which is installed to above CD-ROM 

 

USB port

PC sideRecorder side

1.4 Recommended operating environment 
• Microsoft Windows 2000 or XP. (Operation by Windows 95/98/Me/NT is not secured.) 
• Hard disk with a free capacity of 30MB or more 
• RAM with 64MB or more 
• USB port 
• USB cable [USB(A) male–USB(miniB) male, or Type PHZP1801] 
• LAN port (when provided with Ethernet option) 
• LAN cable (when provided with Ethernet option) 

Note: Hardware requirements of the loader are as follows when it is used for program versions 
V01A to V22A of the paperless recorder GR200. 
• RS-232C serial port (D-sub 9 pin) 
• Communication cable dedicated to parameter loader (Option: PHZP0201) 
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1.5 Installing the parameter loader for paperless recorder 
1) If other application software programs are open, terminate all of them. 
2) If the programming loader has been already installed, open “Add/Remove Programs” on 

Control Panel and delete the parameter loader. 
3) Set CD-ROM in the personal computer drive. 
4) Start “Setup. exe” in the CD-ROM. 
5) Follow the prompts displayed on the screen. 
6) Please install the main body of the parameter loader.  

A message is displayed, prompting you to verify that “Parameter loader setup is complete”. 
Now, the Parameter Loader installation is completed. 

 

 

1.6 Installing USB communication driver 
The driver can be installed on Windows XP as follows for example. 

1) Connect the USB port of the paperless recorder whose power has been turned on and a 
running PC with a USB cable. 

2) The message “Found New Hardware” and then the driver installation wizard appear on the 
computer.  Click the [Next] button. 
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3) When the dialog box below is displayed, select [Display a list of the known drivers for this 
device so that I can choose a specific driver] and click the [Next] button. 

 

4) The dialog box below is displayed.  Select [Other Devices] and click the [Next] button. 

 

5) The dialog box below is displayed.  Click [Have Disk]. 
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6) The [Install From Disk] dialog box is displayed.  Click the [Browse] button. 

 

7) The USB driver “OP-U.inf” is automatically stored in the “inf” folder within the install folder 
(“C: ¥ Program Files ¥ ParameterLoader” usually) of the parameter loader.   
Select the “OP-U.inf” file and then click “Open.” 

 

8) The previous dialog box is displayed again.  Check the path shown under [Copy 
Manufacturer’s Files From:] and click the [OK] button. 

 

9) The dialog box below is displayed.  Check that [Operation Panel USB Driver] is shown 
under [Models:].  Click the [Next] button. 
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10) The driver installation starts. 

 

11) The dialog box below is displayed on completion of installation.  Click the [Finish] button. 
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Recognition of USB Driver 
When the driver has been installed successfully and the paperless recorder and the computer are 
connected with a USB cable, the [Device Manager] window shows “Operation Panel - Operation 
Panel USB Driver.” 

 

This will disappear when the paperless recorder and the computer are disconnected. 
If [Other Device] or [?] is shown even while their connection via USB is maintained, the USB driver 
may not be recognized. If this happens, uninstall the USB driver once and reinstall it. 
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1.7 Uninstalling the parameter loader software for paperless 
recorder 
For un-installation of the parameter loader for the paperless recorder, proceed from Start of Windows 
→ Setting → Control Panel → Add or delete application. And select Recorder Parameter Loader and 
follow Windows’ instructions and cautions to delete it. 
When you install a different version, be sure to un-install the software, which is currently installed, in 
advance in the above procedures. If not un-installed, it might result in malfunctions such as not 
starting. 

 

1.8 Cautions 
When operating the Loader, be careful of the following items: 

1) The Loader is used for the paperless recorder only. 
2) Initial values on each Loader screen may be different from those of the paperless recorder 

main unit. 
3) For the communication setting for the paperless recorder (“Main Unit Set” → 

“Communication Setting”), the Front communication function should be set to ON. (After the 
Front communication function has been switched from OFF to ON, turn OFF the power once, 
and then turn it ON.) 

4) Before starting the paperless recorder, be sure to assure that the Loader setting is reflected to 
the paperless recorder. 

5) The Loader cannot use more than 1 window at the same time. 
If more than 1 window is open, leave only a single window open and close all of other 
windows (this can be checked on the Window menu). 

6) Whenever you want to write the setting data on parameter loader into paperless recorder, 
please return the display of paperless recorder to Display Mode such as Real Time Trend 
Screen. Don’t display Parameter Setting Screen, or this loader software may miss to write into 
the paperless recorder. 

7) When you use this loader to write into the paperless recorder GR200 which the program 
version is V01A to V05A, and you change the input type to 0 to 5Vdc, paperless recorder 
receives the input type as 1 to 5Vdc instead of 0 to 5Vdc. And then, this loader’s setting is also 
changed to 1 to 5Vdc. (This is because the main unit does not support 1 to 5Vdc input 
function.) 

8) At this loader, some parameters which do not exist on paperless recorder may be displayed. 
But the parameter which doesn’t exist in paperless recorder isn’t written. 

9) During the paperless recorder is recording or totalizing, it is impossible to write into the 
equipment from this parameter loader. 
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2. BASIC OPERATION 
 
2.1 Start 

Click “Programs” ⇒ “Recorder Parameter Loader” ⇒ “Recorder Parameter Loader” from the Start 
menu. 

 

It is displayed such as following screen. 
Note) The screen for maximum channels is displayed, regardless of the number of channels of the 

paperless recorder. 

 

Table of setting channel display 
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2.2 Table of setting channel display 

 

 

 

(8) Copy the setting value 
(7) File menu 

(1) Selection of setting 
model (2) Communication setting 

(5) Setting of the 
paperless recorder is 
stored non-volatile 
memory 

(6) Time setting to 
the paperless 
recorder 

(3) Upload setting value from 
the paperless recorder 

(4) Download setting value to 
the paperless recorder 

 

 

 
(1) Selection of setting model 

Setting model can be selected by the parameter loader. 

 

Display contents or setting range on the setting screen varies with each model. 
 GR200 

Channel setting 18 channels (ch1 to 18) 
Calculation channel setting None 
DI setting 10 
DO setting range 28 
Screen group setting 4 groups 
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(2) Communication setting 
The setting on the communication with the paperless recorder can be made. 

a) Communication 
The communication method with the paperless recorder can be selected from USB, Ethernet, 
and RS-232C. 
Note: 
1) USB or Ethernet communications cannot be conducted if the program version of the 

paperless recorder GR200 is V01A to V22A. Make sure to set the station No. of the 
parameter loader to 1. 

2) RS-232C communications cannot be conducted if the program version of the paperless 
recorder GR200 is V27A or later. Note that to conduct Ethernet communications, optional 
Ethernet communication board is necessary. To conduct USB communications, make sure to 
set the station No. of the parameter loader to 1. 

 

b) IP Address, Station No. 
Setting is necessary to conduct Ethernet communications with the paperless recorder. 
IP Address and Station No. of the paperless recorder can be set. 
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c) Port 
Setting is necessary to conduct RS-232C communications with the paperless recorder. 
The communication port of the PC used to communicate with the paperless recorder can be set. 
This function can change communication port of PC which communicates with paperless 
recorder. At starting of this loader, COM1 is selected as communication port. Set the port 
number that you want to use at first.  
At the executing screen, click [Com(R)] → [Port(P)] and select using port. Normally, COM1 is 
selected. (Normally COM1 is selected.) 

 

(3) Upload setting value from the paperless recorder 
It is available to upload all the setting such as channel setting, math channel setting, main 
setting, display setting and so on from the paperless recorder. 

(4) Download setting value to the paperless recorder 
It is available to download all the setting such as channel setting, math channel setting, main 
setting, display setting and so on to the paperless recorder. 
Note: 1) Download prohibit during recording or totalizing. 
 2) After the data has been downloaded to the paperless recorder, store non-volatile 

memory, or the setting value will return to the former value when power is turned 
OFF. 

(5) The data downloaded to the paperless recorder can be stored non-volatile memory. 
(6) Time setting to the paperless recorder 

It is available to change time setting of the paperless recorder. Press [Time setting] button, and 
screen as shown below appears. Set the time that you want to change. And then press [Change] 
button. 
Note: 1) This setting prohibit during recording or totalizing. 
 2) This setting is not necessary to be stored non-volatile memory. 

 

Screen of time setting 
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(7) File menu 
This menu, you can use functions as shown below. 

 

a) [Open(O)] 
Paperless recorder parameter setting files stored in your PC can be opened. 
Parameter setting files stored in the paperless recorder can also be opened. 

b) [Save in file(S)] 
Parameters currently being set can be stored in your PC. For parameter setting file to be 
created, extensions vary depending on setting model. 
In case of GR200: ******GR200 
 

Parameter setting file to be created: *****.GR200 
Substitute ***** with an arbitrary name. Select a file name consisting of alphanumeric 
characters with 7 uppercase characters or less when a parameter setting file is to be read from 
a compact flash card to the paperless recorder. 
Example: 
OK: PARA00.GR200, P123456.GR200 NG: Para00.GR200, P1234567.GR200 
 
(CAUTION) 
If the Parameter Loader setting file is made, and to be load from a compact flash card to the old 

version paperless recorder (V39Aprevious), there are few points that the user needs to be cautions of. 

 

①The password for Start/Stop Recording should be set to"0".  

If "0" is not set, everytime during Start/Stop recording operation, the Password Setting screen 
will display. 

②Set all the recording operation channel to "Display Only". 
  If it is not set to "Display Only", during recording, the operating channel of Measure Value will 

be recorded. 
 

However, the stated above will not occur when a setting value is written via communication. 
When the stated above does occur, the user needs to re-set the setting value again and start all 
over again. 
 

c) [Text output(T)] 
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Output setting value as text data.. 
Please refer to attached “Appendix. 1: Example of setting parameters to be printed out.” 

d) [Exit(X)] 
Exit this menu. 

Note: 1) If you change setting value of the paperless recorder, register the setting value before 
exit this software. 

 2) If you want to use setting value on another day, it is recommended to save the setting 
value file of the paperless recorder before exit this software. 

(8) Copy the setting value 
Copy the setting value such as channel setting, main setting, display setting and so on. 
Click in line of original data and press [Copy]. Click in line that you want to copy, and then 
press [Paste]. 
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2.3 Setting channels 
Set the parameter regarding to input, calculation, alarm, display and record of each channel. 
On “Table of setting channel display”, double-click the channel you want to change. 

 

And then channel setting display appears. 
* Settable number of channels depends on setting model.  

In case of GR200, it is available to set till 18ch regardless of number of channels. 
 

* There are some screens to be able to display up to 7 characters as channel tag in spite of setting is 
available up to 8 characters. So don’t set 8 characters as channel tag. 

* When you set out of the range, message as shown below appears. 

 

Message in recording range 
 

* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off 
and on the paperless recorder, setting value returns before you change. 
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* The input type becomes same kind in every two channels set. 
(1) When input type of each channel is changed, setting is subjected to limitations. 

In case of GR200: The type setting of channel 2, 4, 6, 8, 11, 13, 15 and 17 is available 
only with the same input category of previous channel. Note that, channel 9 
and 18 can select the input type regardless of other channels. 

 
 
 
 

 
Input type is shown as follows. 

Input category Input type 
Thermocouple, 50mV K-Type TC, E-Type TC, J-Type TC, T-Type TC, R-Type TC, S-Type 

TC, B-Type TC, N-Type TC, W-Type TC, L-Type TC, U-Type TC, 
PN-Type TC, 50mV 

Resistance bulb Pt100Ω, JPt100Ω 
500mV 500mV 
5V 1 to 5Vdc, 0 to 5Vdc 

 
For example, when channel 1 is set to 1 to 5V, channel 2 is available to set only 1-5V, 0-5V, or 
Skip as shown below. 
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Example: Setting input type of each channel 
 Input type Input type Explanation 
Channel 1 K-Type TC 
Channel 2 T-Type TC 

Thermocouple, 50mV It is available to set any type of TC to each 
channel. 

Channel 3 1 to 5V 
Channel 4 0 to 5V 

5V  

Channel 5 Pt100 
Channel 6 JPt100 

Resistance bulb It is available to set any type of resistance 
bulb to each channel. 

Channel 7 500mV 
Channel 8 500mV 

500mV  

Channel 9 J-Type TC Thermocouple, 50mV It is available to set any input type to 
channel 9. 

Channel 10 K-Type TC 
Channel 11 50mV 

Thermocouple, 50mV The same input type is basically allocated 
to 2 channels. 

Channel 12 Skip 
Channel 13 1 to 5V 

5V 

Channel 14 Pt100 
Channel 15 Skip 

Resistance bulb 

Channel 16 Skip 
Channel 17 500mV 

500mV 

It is available to set skip under any input 
type. 

Channel 18 50mV Thermocouple, 50mV It is available to set any input type to 
channel 18. 

 
(2) When the input type of the channel is changed, the initialization of the input type of next 

channel might be required. 
In case of GR200: 
When the input type for channels 1, 3, 5, 7, 10, 12, 14 and 16 is changed, the initialization of the 
next channel might be required. 
 
 
 
 
 

 

At this screen, if you press [OK] button, the input type of next channel is initialized to the same 
input type of current displayed channel. In case of 50mV, the next channel becomes K-type TC. 
In case of resistance bulb, the next becomes Pt100Ω. 
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* When you set input unit, set ON the “Scaling” at first. And then press “SELECT” key.  
In case of Thermocouple or Resistance bulb input, it is available to select either Celsius or 
Fahrenheit. And the others unit are not displayed. 

 

 
The Unit Select screen appears. On the screen that is displayed, click a unit and press the 
[Apply] button. Note that the unit cannot be selected without pressing the [Apply] button. 

 

Example: At voltage input and scaling ON 
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2.3.1 Copying the channel set 
This screen allows you to copy one or more set values from one channel to another. 
Move the cursor to CH on the Table of Setting Channel display, and click it (channel selection). 
Click [Edit] → [Copy]. 

 
 

 

Click “Copy”. Select channel.

Move the cursor to CH where you want to paste channel settings and click it (Channel selection). 
Click [Edit] → [Paste]. 

 
 

 

Select “Paste”. Select “CH”. 
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Next, the following message appears, prompting you to select the option. 
Click [OK] when you want to copy the channel setting. 
If the input type is different between current type and new one, the paperless recorder works such as 
below. 

 
(1) Copying of Channel Setting in GR200 

1) When the copy destination is cannels 1 to 8, and 10 to 17: 
The same input types (*2) are used for their paired channels (*1). 
(*1: The paired channels are 1ch and 2ch, 3ch and 4ch, 5ch and 6ch, 7ch and 8ch, 10ch and 
11ch, 12ch and 13ch, 14ch and 15ch, and 16ch and 17ch.) 
(*2: The K thermocouple input is used for the thermocouple, and the Pt100Ω input for the 
resistance thermometer.) 

2) When the copy destination is 9ch and 18ch: 
No channel changes other than 9ch and 18ch. 
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2.4 Setting of Computing Channel 
Settings of the arithmetic expression, input, integration, warning and display record for each 
computing channel are performed. Put the cursor on the desired channel in the screen, displaying the 
list of the computing channel settings, and double-click it. 

 

The computing channel setting screen appears. 
* Number of math channels differs according to model setting. 
 When GR200 is selected : It is available to set till 12 channels between ch19 and ch30. 
* There are some screen to be able to display up to 7 characters as channel tag in spite of setting is 

available up to 8 characters.  So don’t set 8 characters as channel tag. 
* When you set out of the range, message as shown below appears. 

 

Recording range display 
* Press [Apply] after changing channel setting, or your setting isn’t registered, so when you turn off 

and on the recorder, setting value returns before you change. 
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2.4.1 Setting of Arithmetic Expression 
Click the “Setting” button in the computing channel setting screen. 

 

The arithmetic expression setting screen appears. 
Select an arithmetic function and an input value and click “OK”. 

 
〈 List of functions usable for arithmetic expression 〉 

Display Function Description 
No display No arithmetic operation No arithmetic operation is performed. The input value is 

used as is. 
ABS(A) Absolute value The absolute value of the value in the input A is found. 
POW(A,B) Exponentiation The “input B” power of the value in the input A is 

calculated. 
SQR(A) Square root The square root of the value in the input A is calculated. 
LOG(A) Log The common logarithm in the input A is calculated. 
LN(A) LN The natural logarithm in the input A is calculated. 
EXP(A) EXP “e exponentiation” of the value in the input A is 

calculated. 
RH(A,B) Humidity The relative humidity is calculated when the input A is 

dry-bulb temperature and the input B is wet-bulb 
temperature. 

MAX(A,B) Maximum value  
(between channels) 

The inputs A and B are compared to find the bigger 
value. 

MIN(A,B) Minimum value  
(between channels) 

The inputs A and B are compared to find the smaller 
value. 

H-P(A) Maximum value (time) The maximum value in the input A during a specified 
time is found. 

L-P(A) Minimum value (time) The minimum value in the input A during a specified 
time is found. 

AVG(A) Average value The average value in the input A during a specified time 
is calculated 

SUM(A,B) Cumulative value The cumulative value in the input (A/B) during a 
specified time is calculated. Cumulating calculation is 
performed every minute. 

 
〈 List of inputs usable for arithmetic expression 〉 

Display Content Display example 
Channel Channel input C01 
Cumulating calculation Channel cumulative value T01 
DI DI input D01 
Communication Communication input M01 
Constant Constant K01 
Temporary data Result of the last expression B01 
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2.4.2 Copying of Computing Channel 
A setting value is copied to other computing channel. 
Put the cursor on the channel to be copied in the computing channel setting list screen, and click it 
(channel selection).  
Click the “Edit” menu and select “Copy”. 

 
 

 

Click “Copy”. Select channel.

Put the cursor on the copy destination and click it (channel selection).  
Click the “Edit” menu and select “Paste”. 

 
 

 

Select “Paste”. Select “CH”. 

Then the confirmation message appears.  
When the “OK” button is pressed, copying is performed. 
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2.5 Setting the main unit 
This screen allows you to set the recorder main unit. 
Move the cursor to “Main setting” on the Table of Setting Channel display, and click it. 

 

The Main unit Set screen appears. 
* Settable items vary depending on setting model.  

(The above screen is displayed when the setting model is GR200.) 
* If values are entered over the specified range, the following message appears. 

 

Alarm Hysteresis message 
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2.5.1 DI function (external control unit) setting (option) 
The DI function determines whether ON/OFF input from external devices connected to external 
terminal is accepted or not.  
DI point varies depending on setting model.  

GR200: DI1 to DI10 (Max. 10 points) 
 

 

Note: Without the DI option, DI function cannot be used. 
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2.6 Display setting 
At this screen, you can see or set regarding to screen setting such as structure of screen, trend display 
screen and so on. Click “Display setting” tab of Structure of setting channel display. 

 

 

Setting screen appears and you can see status about screen setting. 

 
2.6.1 Display setting 

At this screen, you can set regarding to screen setting such as structure of screen, trend display screen 
and so on. Double click the group No. at “Display group” column on Display setting screen,  
* Edit the displayed group on “Selected group No.”. 
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* Screen name (up to 16 characters) can be set to the recorder. 
* If scale display is ON, trend screen is divided in accordance with the scale, not the setting of 

“Display divided”. 

 
2.6.2 Setting channels 

Set the structure of screen. 
No.1 at this screen equals to data 1 of “display setting” of the paperless recorder, No.2 equals to data 2. 
Following is the same as above until No.10. 
* In case of the paperless recorder is 9 inputs type, this screen displays until No.10. 
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2.6.3 Setting message 
The screen allows you to set messages to be displayed when an event occurs. 
Move the cursor to No. of the Message box on the Main Unit Set screen and double-click it. 

 

The Message Setting screen appears. 

 
* Up to 32 characters is available for the message. The characters exceeding 32 cannnot be displayed 

on the recorder main unit. 

 
* After the input of message set data, be sure to press the “Apply” button, or the message cannot be 

registered. 

 
* Message timing is allocated as follows: 

 

 
 
 
 
 
Channel No. 
Set alarm No. 

 

 
 
 
 
 
DI No. 
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2.6.4 Unit coding 

Units can be made in alphanumerical characters. This unit can be registered in the input unit when 
scaling is set to ON on the Channel Setting screen. 
Move the cursor to No. of the Unit box on the Main Unit Set screen and double-click it. 

 

The Unit Setting screen appears. 

 
* A message (unit) consisting of up to 7 characters is available for the recording main unit. 

 
* After the input of unit set data, be sure to press the “Apply” button, or the unit cannot be 

registered. 
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2.7 Ethernet communication setting 
Settings related to Ethernet communications such as IP address, user name, operation setting of each 
Ethernet communication function of the paperless recorder can be checked or made. 
* Ethernet communication function cannot be used unless the paperless recorder main unit is 

provided with Ethernet communication option. 

 

* Up to 16 characters can be entered as user name. 
* Up to 8 characters can be entered as password. 

 

  29 



 

2.8 E-mail communication setting 
Settings related to E-mail communications such as send/receive address and send trigger can be made. 
* E-mail communication function cannot be used unless the paperless recorder main unit is provided 

with Ethernet communication option. 

 

* Up to 64 characters can be entered as send/receive address. 
* Up to 32 characters can be entered as sender name. 
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2.8.1 E-mail trigger setting 
Other conditions for E-mail transmission can be selected as follows. 
Move the cursor to “E-mail trigger” on the E-mail setting screen and double-click it. 

 

* Up to 32 characters can be entered as the title of E-mail and comments 1 and 2. 
* Be sure to press the [Apply] button to confirm the E-mail trigger setting data that has been entered. 
* E-mail trigger timing is allocated as shown below. 

 
• When sending E-mail by DI operation 

 

• When sending E-mail by alarm operation 

 

Alarm No. 

Channel No. DI No. 
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• When sending E-mail by alarm operation of 
the main unit 

 

• When sending E-mail at fixed intervals 
 

 

Reference time 

Transmission internalAlarm contents 
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APPENDIX.1 EXAMPLE OF SETTING PARAMETERS 
TO BE PRINTED OUT 

 

 

 

2006/03/21 20:20:39   

 

PILC   : GR200-0AM000006020                     

Ser.No.: LYT0006T           

Ver.   : V31A               

 

*****Channel setting*****           

      Other CH Scaling Measuring range Engineering unit   

 Input type Color  Tag No.1 Tag No.2 Input unit Input ON/OFF1 Min Max Min Max 

CH1 K-Type TC Sky blue Tag 01 Tag 2-01 ﾟC channel 1 OFF 0.0 500.0 0.0 500.0   

CH2 T-Type TC Yellowish green Tag 02 Tag 2-02 ﾟF channel 1 OFF 0.0 500.0 0.0 500.0   

CH3 Pt100 Violet Tag 03 Tag 2-03 ﾟF channel 1 OFF 0.0 500.0 0.0 500.0   

CH4 JPt100 Green Tag 04 Tag 2-04 ﾟC channel 1 OFF 0.0 500.0 0.0 500.0   

CH5 500mV Deep green Tag 05 Tag 2-05 mV channel 1 ON 2.0 522.0 -500.0 550.0   

CH6 500mV Purple Tag 06 Tag 2-06 mV channel 1 OFF 0.0 500.0 0.0 500.0   

CH7 500mV Red Tag 07 Tag 2-07 mV channel 1 OFF 0.0 500.0 0.0 500.0   

CH8 500mV Yellow Tag 08 Tag 2-08 mV channel 1 OFF 0.0 500.0 0.0 500.0   

CH9 0-5V Indigo Tag 09 Tag 2-09 V channel 1 ON 0.123 5.123 1.900 5.900   

CH10 B-Type TC Dark red Tag 10 Tag 2-10 ﾟC channel 1 OFF 0.0 500.0 0.0 500.0   

CH11 50mV Red Tag 11 Tag 2-11 mV channel 1 OFF 0.00 50.00 0.00 50.00   

CH12 500mV Blue Tag 12 Tag 2-12 mV channel 1 ON 10.0 502.0 0.5200 0.0000   

CH13 500mV Violet Tag 13 Tag 2-13 mV channel 1 OFF 0.0 500.0    0.0 500.0   

CH14 JPt100 Purple Tag 14 Tag 2-14 ﾟF channel 1 OFF 0.0 500.0    0.0 500.0   

CH15 Pt100 Deep green Tag 15 Tag 2-15 ﾟF channel 1 OFF 0.0 500.0    0.0 500.0   

CH16 0-5V Purple Tag 16 Tag 2-16 V channel 1 OFF 0.000 5.000  0.000 5.000   

CH17 0-5V Pale blue Tag 17 Tag 2-17 V channel 1 OFF 0.000 5.000  0.000 5.000   

CH18 1-5V Blue Tag 18 Tag 2-18 V channel 1 ON 2.000 4.000 80 5008   

 

 Square Input    Subtract Fvalue Recording Recording Display range 

 Rooter filter PV shift PV gain channel calc. mode type Min Max 

CH1 OFF 3   1.0  100.01 None OFF With record Min-Max value 0.0 200.0   

CH2 OFF 0   0.2  100.02 None OFF With record Point value 32.0 572.0   

CH3 OFF 3   0.3  100.03 channel2 OFF With record Average value 32.0 932.0   

CH4 OFF 4 400.0  140.00 channel9 ON With record Min-Max value 4.000 5.004   

CH5 OFF 5 -50.0   50.00 channel4 OFF With record Point value 0.5 500.0   

CH6 OFF 6   0.6  100.00 channel5 OFF With record Average value 0.6 500.6   

CH7 OFF 7   0.0  100.00 None OFF With record Min-Max value 0.0 500.0   

CH8 OFF 8   0.0  100.00 None OFF With record Point value 0.0 500.0   

CH9 ON 0 9.000  109.00 channel2 ON With record Average value 0.900 5.090   

CH10 OFF 3   1.0  101.00 None OFF With record Min-Max value 600.0 700.0   

CH11 OFF 3  0.00  100.00 None OFF With record Point value 0.00 50.00   

CH12 ON 90 0.1000  100.00 channel18 ON With record Average value 5.000 0.000   

CH13 OFF 3   0.0  100.00 None OFF With record Min-Max value 0.0 500.0   

CH14 OFF 10  10.0   90.00 channel18 ON With record Point value 0.000 5.000   

CH15 OFF 5   0.0  100.00 channel3 OFF With record Average value 0.0 500.0   

CH16 OFF 3 0.000  100.00 None OFF With record Min-Max value 0.000 5.000   

CH17 OFF 3 0.000  100.00 None OFF With record Point value 0.000 5.000   

CH18 ON 20 0    0.00 None OFF With record Point value 1 10   

 

*****Totalize setting***** 

 Totalize Totalize Totalize External Totalize Reset Totalize Totalize Totalize 

 Tag calc. Type input Base time operation Unit Cut value Scale value 

CH1 STAG 01 Totalizer Monthly DI3 /h ON ppmCO 10.0 2 

CH2 TAG 02 Totalizer OFF Ch1 Alarm2 /min OFF rps 0.0 3 

CH3 STAG 03 Totalizer Daily DI1 /h ON SEC 0.0 4 

CH4 TAG 04 Totalizer Daily DI1 /h ON m/s2 0.010 3600 

CH5 STAG 05 Totalizer Daily DI3 /min OFF uGy/h 50.0 9999 

CH6 STAG 06 Totalizer Annual Ch6 Alarm3 /day OFF dB 60.0 160 

CH7 STAG 07 Totalizer OFF DI1 /h ON %NaCl 0.0 32767 

CH8 TAG 08 Totalizer Daily DI1 /h ON  0.0 1 

CH9 STAG 09 Totalizer Monthly Ch13 Alarm3 /day ON m/min 0.090 19 

CH10 STAG 10 Totalizer External input DI1 /min ON mol 370.0 32 

CH11 STAG 11 Totalizer Daily DI1 /h ON  0.00 100 

CH12 STAG 12 Totalizer OFF DI9 /s OFF km/h 1.200 54 

CH13 STAG 13 Totalizer Daily DI1 /h ON  0.0 3 

CH14 STAG 14 Totalizer Daily DI1 /h ON min 1.100 1 

CH15 STAG 15 Totalizer OFF DI1 /min OFF mm/min -10.0 15 

CH16 STAG 16 Totalizer Daily DI1 /h ON  0.000 65 

CH17 STAG 17 Totalizer OFF DI1 /s ON uGy/h 0.170 17 

CH18 STAG 18 Totalizer Daily DI1 /h ON  0 18 

 



 

*****Alarm setting***** 

 Alarm No.1   Alarm No.2   Alarm No.3   Alarm No.4 

 Alarm Alarm set DO relay Alarm Alarm set DO relay Alarm Alarm set DO relay Alarm Alarm set DO relay  

 type value No. type value Ｎo. type value No. type value No. 

CH1 H   100.0  1 H 100.0  2 H   100.0  3 H   100.0  4   

CH2 H   800.0 None OFF   0.0   None OFF   0.0   None L   200.0   None   

CH3 OFF   0.0 None OFF   0.0   None OFF   0.0   None  OFF   0.0   None   

CH4 H   0.400  1 OFF 0.040  2 L   0.004  5 OFF 4.000  3   

CH5 H    50.0 28 L    50.0 27 H    50.0 26 L    50.0 25   

CH6 H   500.0  1 OFF   0.0 None OFF   0.0   None OFF   0.0   None   

CH7 OFF   0.0 None OFF   0.0 None OFF   0.0   None OFF   0.0   None   

CH8 OFF   0.0 None OFF   0.0   None OFF   0.0   None OFF   0.0   None   

CH9 L   0.900 3 H   0.900  5 L   0.900  6 H   0.900 28   

CH10 OFF 600.0  5 H   600.0   None L   600.0 22 H   600.0   None   

CH11 OFF  0.00 None OFF  0.00   None OFF  0.00   None OFF  0.00   None   

CH12 L   0.100 4 H   0.200  6 OFF 0.300   None OFF 0.400 27   

CH13 OFF   0.0 None OFF   0.0   None OFF   0.0   None  OFF   0.0   None   

CH14 H   0.000 None L   0.000   None  OFF 0.300   None  OFF 0.500   None   

CH15 L    40.0 None H    30.0 5 H 20.0 27  OFF 10.0  4   

CH16 OFF 0.000 None OFF 0.000   None OFF 0.000 None OFF 0.000   None   

CH17 OFF 0.000   None OFF 0.000   None OFF 0.000   None OFF 0.000   None   

CH18 OFF  1000   None H    1000   None L    1000   None  H    1000   None   

 

*****Main setting***** 

Display refreshment cycle  1 sec        Alarm hysteresis    1.32  (%)     Alarm latch OFF       

LCD lights-out time      0  min  Memory full alarm  DO No.      5     Battery alarm DO No.      4   

Modbus station No.      1    Modbus baud rate  19200  bps       Modbus parity Odd       

Recording data format Binary     Display time format Mar-21-06        File division cycle No division   

 

*****Fvalue calculation setting***** 

Target temperature   100.0  ゚ C     Z value   200.0  ゚ C     Decimal point position      3   

Reset temperature    10.0  ゚ C 

 

*****Totalize setting***** 

Daily totalize cycle 12 hour    Annual base day     31   

Extrnal input DI1              

 

Program version V14A exclusive use totalize setting 

Totalize calculation OFF             Totalize base time /h             Totalize recording cycle 12 hour   

Start/Stop timing Manual             Start time-Stop time 23:06    - 22:59     

 

*****Display setting***** 

 Content of screen composition 

 No.1 No.2 No.3 No.4 No.5 No.6 No.7 No.8 No.9 No.10 

Display group1 channel1 channel2 channel3 channel4 channel5 channel6  channel7 channel8 channel9 channel10 

Display group2 channel11 channel12 channel13 channel14 None None None None None None  

Display group3 channel15 channel16 channel17 channel18 None None None None None None  

Display group4 channel1 channel2 channel3 channel4 None None None None None None  

 

  Trend Display Scale Bar graph/ Color bar 

 Display name direction division No. display Analog meter display selection 

Display group1 1.Diplay Group1 Vertical 20 ON Bar graph Tag No. 

Display group2 2.Diplay Group2 Horizontal 13 ON Analog meter Channel No. 

Display group3 3. Diplay Group3 Vertical 7 OFF Bar graph Unit 

Display group4 4.Diplay Group4 Horizontal 10 OFF Analog meter Tag No.   

 

*****Message setting***** 

 Message Timing1 DI NO./  

   Alarm Channel Alarm NO. 

No.1 Massage DI1 ON DI ON DI1 

No.2 Massage DI5 OFF DI OFF DI5  

No.3 Massage Channel18 Alarm No.1 ON Alarm ON CH.18 Alarm No.1  

No.4 Massage Channel18 Alarm No.1 OF Alarm OFF CH.18 Alarm No.1  

No.5 Massage DI4 ON DI ON DI4  

No.6 Massage Channel18 Alarm No.3 OFF Alarm OFF CH.18 Alarm No.3  

No.7 Massage Channel18 Alarm No.2 ON Alarm ON CH.18 Alarm No.2  

No.8 Massage DI4 OFF DI OFF DI4  

No.9 Massage Channel05 Alarm No.4 OFF Alarm OFF CH.5 Alarm No.4  

No.10 Massage Channel04 Alarm No.2 ON Alarm ON CH.4 Alarm No.2  

 

*****Original Unit definition***** 

        No.1       No.2       No.3       No.4       No.5       No.6 

Unit                        mPa        SEC                               

        No.7       No.8       No.9       No.10      No.11      No.12 

Unit                                                                     

 

*****DI function setting***** 
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DI-1  Rec start/stop DI-6  Rec start/stop 

DI-2  Fvalue calc. reset DI-7  Rec start/stop 

DI-3  Totalize start/stop DI-8  Fvalue calc. reset 

DI-4  Function invalid DI-9  Totalize start/stop  

DI-5  Rec start/stop DI-10 Totalize reset 

 

*****Ethernet setting***** 

Ethernet setting 

IP Address   192 . 168 . 0 .   2   

Subnet mask 255 . 255 . 255  .   0   

Default gateway 0 .   0 .   0  .   0   

 

FTP server setting 

FTP server function ON     

Access control ON     

 

Web Server setting 

Web server function ON     

 

E-mail setting 

E-mail function ON     

 

MODBUS TCP/IP setting 

MODBUS TCP/IP function ON     

 

User account setting 

  User name Password User level 

1. SystemTaro a19b23 Administrator 

2. KirokuKeiko 65790 Guest 

3.    Administrator 

4.    Administrator 

5.    Administrator 

6.    Administrator 

7.    Administrator 

8.    Administrator 

 

*****E-mail setting***** 

SMTP(Mail server) IP address   192  . 198  .   0  .   1   

Sender's mail address boiler035@test.co.jp    

Sender's name Boiler035        

 

Receiver's mail address 

1.  System-Taro@test.co.jp        

2.  Kiroku-Keiko@test.co.jp 

3.     

4.      

5.      

6.      

7.      

8.      

 

E-mail trigger setting 

 Title Text 1 Text 2 

No.1 Product1 manufacturing beginning Product1 manufacturing beginning Boiler035  

No.2 Boiler035 report at regular time Report at regular time Boiler035  

No.3 The temperature is abnormal! The temperature is abnormal. Boiler035 

No.4 

No.5  

No.6  

No.7 

No.8 

No.9  

No.10 

 

Trigger timming Timming1 Timming2 PV Value  No1 No2 No3 No4 No5 No6 No7 No8 

No.1 DI ON DI2 - ON ON ON OFF OFF OFF OFF OFF OFF    

No.2 Timer cycle 12hour 01:00 ON ON OFF OFF OFF OFF OFF OFF OFF    

No.3 Alarm ON channel1 No.4 ON ON ON OFF OFF OFF OFF OFF OFF    

No.4 None - - OFF OFF OFF OFF OFF OFF OFF OFF OFF    

No.5 None - - OFF OFF OFF OFF OFF OFF OFF OFF OFF    

No.6 None - - OFF OFF OFF OFF OFF OFF OFF OFF OFF    

No.7 None - - OFF OFF OFF OFF OFF OFF OFF OFF OFF    

No.8 None - - OFF OFF OFF OFF OFF OFF OFF OFF OFF    

No.9 None - - OFF OFF OFF OFF OFF OFF OFF OFF OFF    

No.10 None - - OFF OFF OFF OFF OFF OFF OFF OFF OFF    
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